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This booklet is designed as a handout for use in a workshop on The Geometer’s
Sketchpad or for use—in conjunction with the Instructor’s Evaluation Edition of
The Geometer’s Sketchpad—in evaluating the program for possible purchase.
Note: The Instructor’s Evaluation Edition of The Geometer’s Sketchpad will
expire after 60 days, at which point it will cease to operate on the computer
on which it was installed. Reinstallation of the software will not extend the
period of operability. Workshop leaders should use the fully functional
version of Sketchpad to avoid problems with expiration.

To the Workshop Participant
The tours in this booklet will introduce you to many of Sketchpad’s features and to methods
for using Sketchpad in the classroom. It’s easy to retrace your steps, so feel free to explore on
your own. Ask for help when you get stuck and offer to help others when you can.
At the end of the workshop, you may take this booklet with you and use it with the
Instructor’s Evaluation Edition of Sketchpad to explore and evaluate Sketchpad.
(You can download the Instructor’s Evaluation Edition of Sketchpad from the web at
http://www.keypress.com/sketchpad.) But remember that the Instructor’s Evaluation
Edition of Sketchpad and this Workshop Guide are for teacher education and evaluation
only, and are not for classroom or other extended use.

How Is the Instructor’s Evaluation Edition Different from the “Real Thing”?
The Instructor’s Evaluation Edition of Sketchpad does everything the full version does
with a few important exceptions: You can’t print, save, or export your work, and the
extensive help system is missing. The full version of Sketchpad includes extensive
documentation, teacher support materials, and the help system. Documentation includes
a Learning Guide, a 252-page Reference Manual, and Teaching Mathematics, which provides
tips for using Sketchpad in the classroom and 25 reproducible sample classroom activities.

To the Workshop Presenter
A successful workshop balances providing guidance with allowing participants to
explore on their own. Allotting specific amounts of time for small chunks of each tour
works best, so time intervals are marked in the tours. Use a watch or a kitchen timer, and
interrupt participants at the end of each section. Ask for questions and demonstrate what
they’ve just done on the overhead, if one is available. Keep things moving along and
ensure that nobody spends too long stuck on a particular concept.
In addition to teaching the participants about Sketchpad, you should also be teaching
and modeling good “lab etiquette.” When participants have a question, they should ask
their neighbors—whether it’s a question about math or about Sketchpad—before asking
you. When answering participants’ questions, avoid the temptation to take over their
computer! They’ll learn by doing it themselves, not by watching you do it. (Participants
should abide by the same rule.)
Make sure that the participants know the agenda for the day and that they are aware of
the range of activities and resources available to them. Encourage them to explore on
their own when they’ve finished a scheduled activity, but to choose materials that won’t
be specifically covered during the workshop.
Key Curriculum Press gives copy permission to any presenter who wants to use this
Workshop Guide in a teacher-education workshop. Remind participants that the
Instructor’s Evaluation Edition of Sketchpad and the Workshop Guide are for evaluation
purposes only, and are not for classroom or other extended use.
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Tour 1: Constructing a Square
In this tour, you’ll learn about Sketchpad’s basic tools and get a first taste of
constructing a geometric figure—a square.

What You Will Learn
•

How to construct segments and circles

•

How to select and drag objects

•

How to construct lines that are perpendicular
or parallel to other lines

•

How to construct points at the intersection of
two objects

•

How to save Sketchpad documents

•

How to use the Undo command to backtrack
through your actions

Free Play
Presenter: Once all participants have launched Sketchpad, allow about 10 minutes for
Free Play. Stop once all the participants have completed this section.
To begin learning about Sketchpad, you’ll want to experiment with the various
tools. We’ll start this tour by encouraging you to do just that, giving you just a
little guidance.
1. Start Sketchpad. If Sketchpad is already running, choose New Sketch from
the File menu.
You’ll learn more
about each of these
tools throughout
the tours.

2. Use the Point, Compass, and Straightedge tools to draw objects in the
sketch plane. (Make sure you use all three straightedge tools—the Segment,
Ray, and Line.) After you’ve used each tool at least once, use the Selection
Arrow tool to drag different parts of your sketch. Then try the following
tasks:
• What happens when you use the Selection Arrow to click on the
intersection of two straight objects, two circles, or a straight object and
a circle?
• What happens when you hold down the Shift key when constructing a
segment or other straight object? Is a straight object constructed this way
restricted when dragged in the future, or can it be dragged like any other
straight object?
• Use the Compass tool to draw a circle. Use the Point tool to construct a
point on the circumference of that circle. Use the Selection Arrow to
drag, in turn, each of the three points. How does dragging each point
affect the construction?
• Draw a segment with one endpoint “on top” of another segment or circle.
How does this endpoint move when you drag it with the Selection
Arrow? What happens if you move the segment or circle on which it’s
constructed?

2 • The Geometer’s Sketchpad Workshop Guide

© 2002 Key Curriculum Press

• What happens when you use the Selection Arrow to click on an object?
What happens if you click again on the same object? What happens if
you click in empty space?
• Using the Point tool, construct three independent points. Use the
Selection Arrow to select and drag just one of those points. Now drag
two of them at the same time. Then try dragging all three. Now what if
you only want to drag one?
• Using the Arrow tool again, select one or a small number of objects. See
what commands are available in the Construct menu and try some out.
Presenter: Stop here and answer questions. Go over those items above that seemed to
generate the most questions. Make sure participants understand how selection highlighting determines which objects are dragged and how target highlighting determines
which object gets constructed on which other object. Mention that selection also controls
the availability of menu commands. Allow 15 minutes for the rest of this activity.

Getting Serious
3. When you’re ready to move on, do the following: Choose Undo from the
Edit menu—or, better yet, press Ctrl+Z on Windows or Ô+Z on Mac—to
backtrack through your work.
4. You should now be working in a blank sketch. Choose the Segment tool
from the Toolbox (make sure it’s the Segment tool, not the Ray or
Line tool).
5. Draw a segment to form the bottom side of your square.
6. Using the Compass tool, click first on the right endpoint
and then on the left endpoint of the segment. Each
endpoint should highlight when you click on it. This
constructs a circle centered at the right endpoint of the
segment and passing through the other endpoint.
7. Using the Selection Arrow tool, drag each of the two
points in the sketch to be certain that the circle is attached
to the segment. If it’s not, and there are actually more than
two points in the sketch, Undo the last step in your sketch
and redo step 6.

After step 5

After step 6

8. Click with the Arrow in blank space to deselect all objects.

Constructing Perpendicular and Parallel Lines
Next you’ll construct a line through the center of the circle and
perpendicular to the segment. Notice that we had to state both
of those pieces of information—“through the center of the
circle” and “perpendicular to the segment”—to be clear which
line we meant. Similarly, Sketchpad needs two items to be
selected—a point and a straight object—in order to construct
a perpendicular (or parallel) line.

After step 10
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To construct a
parallel line,
Sketchpad needs to
be given a straight
object to be parallel
to and a point
to pass through
(just as with
perpendicular lines).

9. Select the segment and its right endpoint by clicking on them with the
Arrow. Choose Perpendicular Line from the Construct menu.
10. With the line still selected, select the circle as well. Then choose
Intersections from the Construct menu.
11. Deselect all objects by clicking in blank space. Select the topmost point just
created and the original segment. Then choose Parallel Line from the
Construct menu.
12. Use either Perpendicular Line or Parallel Line to
construct a vertical line through the left endpoint of
the original segment.
13. Deselect all objects. Select the two lines from the last two
steps and choose Intersection from the Construct menu.

Completing the Construction and the “Drag Test”
After step 13

Before you finish your square, let’s see if it passes the “drag
test.” As you did in step 7, use the Selection Arrow to drag
each of the four vertices. Does everything stick together? If so, great! If not,
Undo steps until you figure out what went wrong and try constructing the figure
again. Then move ahead to finish the figure.
14. Select everything except the four corners of the square and the original
segment.
15. Choose Hide Objects from the Display menu. You should see
only what’s in the figure at right. If there’s more in your
sketch, hide whatever is extra. If there’s less, choose Undo
Hide Objects from the Edit menu and try step 14 again.

After step 15

16. Using the Segment tool, construct the remaining three sides
of the square.
Voilà! You have now made your first Sketchpad construction!
Is your figure a
square no matter
how you drag its
parts? If not, it’s not
a true Sketchpad
square. This is
the essence of the
“drag test.”

17. Use the Selection Arrow tool to once again drag different parts of your
square.
18. Choose Select All from the Edit menu to select the entire square. Now
choose Animate Objects from the Display menu. Animating a construction
in this way is an alternative to the drag test.
19. Choose Stop Animation from the Display menu. (You could also click on
the Stop button in the Motion Controller.)
20. Keep your sketch open, as you may use it in a later activity.
Presenter: Stop here, review the construction of the square, and answer questions.
Review the importance of selecting the appropriate objects (and only the appropriate
objects) before choosing a menu command. Give an example of a square that doesn’t pass
the drag test.

Further Challenges
•

See if you can construct the following objects: a rectangle, a parallelogram, a
rhombus, a trapezoid, and an equilateral triangle.
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Tour 2: A Theorem About Quadrilaterals
Sometimes students will have trouble remembering or understanding a
particular theorem. Discovering the theorem themselves or actively exploring
its consequences can make a huge difference in their level of recall and
understanding. This tour challenges you to discover a theorem. As you solve
the challenge, you’ll learn many new Sketchpad features.

When the midpoints of the sides of a quadrilateral are connected, the resulting
shape is always a __________________.

What You Will Learn
•

How to construct a polygon using the Segment tool

•

How to show an object’s label

•

How to measure lengths and angles

•

How to create a caption

•

How to apply formatting options to text

The theorem stated above has a key word left blank. Our goal is to use Sketchpad
to discover what word fills the blank. Don’t worry if this theorem is unfamiliar
or, on the other hand, if it’s too simple. The point is to learn about how to use
Sketchpad for making and testing conjectures.

Constructing a General Quadrilateral
Presenter: Allow 10 minutes for the first three sections.

A “general
quadrilateral” is a
quadrilateral with no
special properties,
such as congruent
sides or right angles.

1. Start Sketchpad if it isn’t already running. If it is running, choose New
Sketch from the File menu.
2. Use the Segment tool to draw a segment.
3. Construct a second segment that shares one endpoint with
the first.

After step 3

4. Construct two more segments to complete the
quadrilateral.
5. Using the Arrow tool, drag some of the points and segments to
make sure the figure holds together—does it pass the drag test?

Constructing the Midpoint Quadrilateral

After step 5

Now that you have a quadrilateral, recall the theorem you’re exploring. It begins
“When the midpoints of the sides of a quadrilateral are connected . . . .” You will
continue by constructing the four midpoints and then connecting them.
6. Deselect all objects by clicking in blank space. Select the four sides of the
quadrilateral in clockwise or counter-clockwise order.
© 2002 Key Curriculum Press

The Geometer’s Sketchpad Workshop Guide • 5

7. Choose Midpoints from the Construct menu.
You can also use the
Text tool to show the
labels. Click on an
object with the Text
tool to display (or
later hide) its label.
Double-click the
label itself to
change the label.

8. With the four midpoints still selected, choose Show Labels from the
Display menu.
9. With the four midpoints still selected, choose Segments from
the Construct menu.

A

10. Use the Arrow tool to drag each point in your figure. Especially
make sure that the midpoints are really midpoints. (Can you
drag them so that they are not?)

D

B

C

After step 9

Dragging and Measuring to Confirm Your Conjecture
You may already have a hypothesis about what kind of quadrilateral the inner
figure is. Be careful, though, because it may be that shape only for a particular
shape of the outer quadrilateral. You need to convince yourself that your
conjecture holds no matter what shape the outer quadrilateral is. This requires
dragging. To gain even more confidence in your answer, you’ll take
measurements as well.
11. Drag various parts of the original quadrilateral around, keeping an eye on
the inscribed figure.
12. Now, select the four inner segments and choose Length
from the Measure menu.
When selecting three
points to measure an
angle in Sketchpad,
the second selected
point is the vertex.

13. Deselect all objects. Then select three consecutive
midpoints and choose Angle from the Measure menu.

m sAB = 1.15 cm
m∠ABC = 84.61˚

14. Select three consecutive midpoints again, with a different
midpoint as the second selected point (vertex), and choose Angle. Repeat
this step two more times, making sure a different midpoint is the second
point selected each time.
15. Choose Calculate from the Measure menu.
m∠ABC + m∠BCD = 180.00˚
Click on the measure for ∠ABC, then click
on the + sign (or type it on the keyboard),
then click on the measure for ∠BCD, then click OK. What does this tell us?
16. Drag various parts of the original quadrilateral, making it wide, skinny,
concave, and so on. What happens to the measurements? What changes, and
what stays the same? Are you more confident of your conjecture now? As
confident as you may feel, do you think you’ve proven the theorem?
Presenter: Stop here, answer questions, and ask different participants to state their
observations or conclusions. Don’t let them jump to the statement of the theorem until
they’ve stated specific observations. Allow 10 minutes for the next section.

Creating a Caption and Using the Text Palette
To finish things off, let’s create a caption for this sketch so that others
who see it will know what’s going on.
17. Choose the Text tool from the Toolbox.
18. Double-click in a blank part of the sketch plane to start a new
caption.
19. Use your keyboard to type the caption, perhaps stating your conjecture
about the inner quadrilateral. Click outside the caption to close it.
6 • The Geometer’s Sketchpad Workshop Guide
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You may have noticed a new set of tools when working with captions (or other
text objects). This is called the Text Palette. You can use the Text Palette to apply
formatting options—such as italics, font size, font color, and more advanced
mathematical formatting—to text. (You can manually show or hide the Text
Palette using Show Text Palette or Hide Text Palette from the Display menu.)

Text Palette (Windows)
While you’re
exploring the Text
Palette, you may
also want to
experiment with
math notation. Click
on the button on the
far right of the Text
Palette to show the
math notation tools.

20. Use the Text Palette to change the font, text color, and other available
settings of the caption. Changes will affect the entire caption because it’s
currently highlighted. Using the Text tool, click and drag within the caption
to highlight a range of text and apply changes just to that text.
21. When you’re done, leave your sketch open in case you want to refer to it later.

Conjecture: When the midpoints of the
sides of a quadrilateral are connected,
the resulting shape is always a . . .
drumroll please . . . parallelogram.

Presenter: Stop and answer question. Emphasize the difference between captions and
labels, and ask participants to describe possible uses they can think of for using captions
in sketches. You may want to demonstrate some of the features of the Text Palette.

Further Challenges
•

In the sketch you just completed, make each segment and the measurement
of its length the same color so that they’re easy to match up visually.

•

Construct a triangle and measure its angles. Show that the sum of the angles
is 180°.

•

Construct a square. Use the Calculator to show that the ratio of the length of
the diagonal to the length of a side is 1.4142 . . .

•

Construct a circle and a radius of that circle. Label the center and the radius.
Measure the circumference and the radius and use the Calculator to find
c/2r.

•

Can you prove your conjecture? Add some things to your sketch to make
your proof more intuitively obvious.
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Tour 3: Algebra Potpourri
Don’t let the name of the program—The Geometer’s Sketchpad—fool you.
Sketchpad has a host of tools for exploring algebra, trigonometry, and calculus,
both symbolically (with equations) and graphically. In this tour, you’ll sample
several of Sketchpad’s algebra features.

What You Will Learn
•

How to create an x-y coordinate system and measure the coordinates of
a point

•

How to define and plot functions

•

How to plot two measurements as an (x, y) point in the plane

•

How to construct a locus
6

f (x) = M⋅x+B
M = 1.66
4
B = 3.28

2

A Simple Plot in the Coordinate (x-y) Plane
Presenter: Allow 10 minutes for the first two sections.
At the heart of “visual” algebra is the x-y (or Cartesian, or coordinate) plane. In this
section, you’ll define a coordinate plane, measure a point’s coordinates on it, and
plot a simple function.
1. Open a new sketch and choose Define Coordinate System from the
Graph menu.
2. Using the Point tool, create a point somewhere other than on an axis.
3. With the point still selected, choose Coordinates from the Measure menu.
Drag the point to see how the coordinates change.
Actually, you can plot
a function without
first creating a
coordinate system.
Sketchpad creates
coordinate systems
automatically
whenever needed.

Now that there’s a coordinate system, let’s plot a
simple equation on it: y = x.
4. Choose Plot New Function from the Graph menu.
5. Click on x in the Function Calculator (or type x
from your keyboard). Click OK.
6. Select the plot you just created and the
independent point (whose coordinates you
measured). Then choose Merge Point To Function
Plot from the Edit menu. Drag the point along the
plot and observe its coordinates.
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You may notice that
the plot’s domain is
restricted. To change
the domain, drag
the arrows at either
end of the plot.

7. Drag the unit point—the point at (1, 0)—to the right and left and observe
how the scale of the coordinate system changes.
8. Release the unit point when the x-axis goes from about –10 to 10.

Plotting a Family of Curves with Parameters
Plotting one particular equation, y = x, is all well and good. But the real power of
Sketchpad comes when you plot families of equations, such as the family of lines
of the form y = mx + b. You’ll start by defining parameters m and b and editing
the existing function equation to include the new parameters. Then you’ll animate
the parameters to see a dynamic representation of this family of lines.

A parameter is a
type of variable
that takes on a
fixed value.

9. Choose New Parameter from the Graph
menu. Enter m for Name and 2 for Value
and click OK.
10. Use the same technique to create a
parameter b with the value –1.

Edit Function
appears as Edit
Calculation, Edit
Parameter, or
Edit Plotted Point
when one of those
types of objects is
selected.

11. Select the function equation f (x) = x (select
the equation itself, not its plot) and choose
Edit Function from the Edit menu.

The New Parameter dialog box (Mac)

12. Edit the function to be f (x) = m ⋅ x + b. (Click on the parameters m and b in
the sketch to enter them. Use * from the Function Calculator or keyboard
[Shift+8] for multiplication.) Click OK.
13. Change m and b (by double-clicking them) to explore several different
graphs in the form y = mx + b, such as y = 5x + 2, y = –1x – 7, and y = 0.5x.
You can learn a lot by changing the parameters manually, as you did in the
previous step. But it can be especially revealing to watch the plot as its
parameters change smoothly or in steps.
14. Deselect all objects. Then select the parameter equation for m and choose
Animate Parameter from the Display menu. What happens?
15. Press the Stop button to stop the
animation.
16. Select m and choose Properties from the
Edit menu. Go to the Parameter panel
and change the settings so they resemble
those at right. Click OK.
17. Again choose Animate Parameter.
18. Continue experimenting with parameter
animation. You might try, among other
things, animating both parameters
simultaneously or tracing the line as it
moves in the plane.

The Parameter Properties dialog box
(Windows)

Presenter: Stop here and answer questions. You may wish to demonstrate modeling
y = mx + b using sliders instead of parameters (perhaps using sliders from the sample
sketch Sliders.gsp). Allow about 15 minutes for the remainder of the activity.
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Functions in a Circle
How does the radius of a circle relate to its circumference? To its area? These are
examples of geometric relationships that can also be thought of as functions and
studied algebraically.
You’ll start by constructing a circle whose radius adjusts continuously along a
straight path.
19. In a new sketch, use the Ray tool to construct a horizontal ray.
20. With the ray still selected, choose Point On Ray from the Construct menu.
In each case, use
the Arrow tool to
select the circle (and
nothing else), then
choose the
appropriate
command in the
Measure menu.

21. With the Arrow tool, click in blank space to deselect all objects. Then select,
in order, the ray’s endpoint and the point constructed in the previous step.
Choose Circle By Center+Point from the Construct menu.
22. Measure the circle’s radius, circumference, and area.
23. Drag the circle’s radius point and watch the
measurements change.
Next we’ll explore these measurements by plotting.

In a rectangular
grid, the x- and
y-axes can be scaled
independently.
Choose Erase
Traces from the
Display menu to
erase this trace at
any time.
A Sketchpad locus is
a sample of possible
locations of the
selected object. To
change the number
of samples plotted,
select the locus,
choose Properties
from the Edit menu,
and go to the
Plot panel.

After step 21

24. Select, in order, the radius measurement and the
circumference measurement. Choose Plot As (x, y) from the Graph menu.
Can you see your point? If not, it might be off the screen.
25. Choose Rectangular Grid from the Graph|Grid Form submenu. Drag the
new unit point at (0, 1) down until you can see the plotted point from the
previous step.
26. Select the plotted point and choose Trace Plotted Point from the Display
menu. Drag the radius point and observe the trace.
In situations such as this (where you trace something as a point moves along a
path) you can often get a smoother picture by creating a locus.
27. Select the plotted point and the radius point;
then choose Locus from the Construct menu.
What is the slope of the line containing this
locus?
28. Repeat steps 24 and 27, except this time
explore the relationship between the radius
and area measurements. How do the two
curves compare? For what radius do the
numerical values of a circle’s circumference
and area equal each other (ignoring units)?

Further Challenges
•

Graph pairs of parallel lines and show that their slopes are the same.

•

Graph pairs of perpendicular lines and show that their slopes are negative
reciprocals.

•

Graph a parabola of the form y = a(x – h)2 + k, using parameters for a, h, and k.
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Tour 4: Investigating Triangle Centers
In this tour, you’ll continue honing your skills at geometric construction by
constructing a triangle’s centroid and other classical triangle centers. Then you’ll
harness Sketchpad’s power in two important new ways: first, by turning your
constructions into custom tools, then by making a multi-page document.

What You Will Learn
•

How to change Sketchpad’s Preferences

•

How to construct a triangle’s centroid and
at least one other classical triangle center

•

How to turn a construction into a custom
tool and how to use that tool to quickly
reproduce the construction

•

How to show the Script View of a custom
tool and how to step through a script

•

How to create a multi-page Sketchpad
document

Constructing a Centroid
Presenter: Allow 15 minutes for the first two sections.
1. Set up Sketchpad so that points are automatically labeled when constructed.
To do this, choose Preferences from the Edit menu, go to the Text panel, and
check For All New Points. Before clicking OK, you may want to explore
what other options are available in Preferences.
2. Use the Segment tool to construct a triangle.
A shortcut: With the
Segment tool active,
choose Select All
Segments from the
Edit menu. Then
choose Midpoints
from the Construct
menu; all three
midpoints are
constructed at once.

3. Construct the midpoints of the three sides.
A

4. Use the Segment tool to construct just two
of the triangle’s three medians. (A median
connects a vertex with the midpoint on the
opposite side.)
5. Using the Point tool or the Selection Arrow
tool, click at the intersection of the two
medians. This constructs the point of
intersection.

E

D
Centroid

B

F

C

6. Label the intersection point “Centroid.”
Before clicking OK, check Use Label In
Custom Tools. (You’ll see why soon.)
7. Construct the third median.
You can also select
the entire figure and
choose Animate
Objects from the
Display menu.

You’re ready to make a conjecture: The
three medians in a triangle intersect in a
single point. But is that true in all triangles?
8. Use the Drag Test to test your
conjecture.
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Turning It into a Custom Tool
It doesn’t take too long to construct a centroid, but if you needed to construct a
lot of them for different triangles, it would be nice to do so quickly. Custom tools
allow you to do just that, as you’ll see in the next section.
9. Select the entire figure. (Either choose Select All
from the Edit menu or use a Selection Rectangle.)
10. Choose Create New Tool from the Custom Tools
menu (the bottom tool in the Toolbox). Name the
tool Centroid and click OK.
11. Click on the Custom tools icon to choose your
new tool. Now click three times in the sketch
plane. You should get a construction just like the original one.
12. Use the tool a few more times, clicking sometimes in blank space and other
times on existing points or segments. Choose Undo Centroid and then Redo
Centroid from the Edit menu and notice that these undo and redo the entire
construction at once. Notice also that while most of the points are given new
labels, the centroid is always labeled Centroid. This is because of what you
did in step 6.
13. Choose the Selection Arrow tool and
click in blank space to deselect all objects.
Then choose Show Script View from the
Custom Tools menu. You’ll see a window
called Centroid Script. This is a readable
description of the construction performed
by the custom tool Centroid. Take a
moment to look through the script and
see how it relates to the construction.
14. Move the Script View window off to the
side (by dragging it by its title bar) but
don’t close it. Select three points in the
sketch. All three Givens should be
highlighted in the Script View window
and you should see two new buttons at
the bottom of the window.
15. Click on the Next Step button as many
times as it takes to get through the entire
script. “Stepping” through a script is a great
way to understand how an unfamiliar tool works or to check student work.
Presenter: Stop here and answer questions. You may wish to demonstrate what would
have happened if participants had constructed all three medians before constructing the
intersection point in step 5. (Namely, if you click with the Arrow tool, you can’t tell to
which two segments the intersection belongs; with the Point tool—or selecting two
segments and using the Intersection command—you can). You may also wish to
briefly introduce the concepts of givens, intermediate objects, and results and perhaps
demonstrate what happens when you create a centroid tool with fewer objects selected
(just the vertices, sides, and centroid).
Allow as much time as you can for the next section. The more time, the more triangle
centers/custom tools each participant will be able to make.
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Creating a Multi-Page Document
When you visit a web site, it’s rare to see all the content on one page—it’s usually
distributed over many linked pages. Similarly, in Sketchpad, you can create
multi-page documents with several pages of related content. Students can use
multi-page documents to create portfolios of their Sketchpad work.
16. Clean up your sketch a bit, perhaps by Undoing back to the point at which
there was just one triangle with its medians and centroid.
17. Choose Document Options from the
File menu. In the dialog box that appears,
choose Blank Page from the Add Page popup menu, then click OK. You’ll now be on
page 2 of a two-page Sketchpad document.
18. Click on the tab marked “1” at the bottom
of the window to go back to the previous
page, then return to the new, blank page.
19. Choose one of the three remaining classical
triangle centers listed below. Construct it on page 2 of your document using
the Toolbox tools and Construct menu commands. Then turn your
construction into a new custom tool, just as you did with the centroid.
Circumcenter: The point of concurrency (intersection) of the perpendicular
bisectors of the three sides of a triangle.
Incenter: The point of concurrency of the three angle bisectors in a triangle.
Orthocenter: The point of concurrency of the three altitudes in a triangle.
Presenter: Stop here and answer questions. You may wish to demonstrate how to use
Document Options to add a duplicate page and to rename and reorder pages.

Further Challenges
•

The centroid divides each median into two smaller subsegments. Use
measurements to explore the length ratio of any pair of subsegments.

•

The three medians of a triangle divide it into six smaller triangles, each
defined by one vertex of the original triangle, one midpoint of an original
side, and the centroid. Construct these six interiors, then measure their areas.
What do you notice? Why is this true?

•

If you constructed a circumcenter in step 19, use it to construct the circumcircle
of its triangle—the unique circle that perfectly circumscribes the triangle.

•

If you constructed an incenter in step 19, use it to construct the incircle of its
triangle—the unique circle that perfectly inscribes the triangle.

•

If you constructed an orthocenter tool in step 19, use it to explore the
following question: Where is the orthocenter of any triangle defined by two
of the vertices and the orthocenter of another triangle? Why?

•

Continue adding pages and tools to your document until there are four pages
and four tools—one for every classical triangle center.

•

Once you’ve completed the previous challenge, apply each of the four tools
to a single triangle. Three of the four centers will lie along the same segment,
called the Euler segment. Which three centers are these? Use measurements to
explore the distance relationships between these three centers.
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Tour 5: Introducing Transformations
Up until now, we’ve focused on the compass-and-straightedge-derived
commands in the Construct menu for doing our geometry. In this tour, you’ll
explore the Transform menu commands, based in transformational geometry, and
ultimately tile the plane with parallelograms.

What You Will Learn
•

How to reflect figures across marked mirrors

•

How to translate figures by marked vectors

•

How to use the Merge command to alter the
geometric properties of figures in a sketch

Reflections of a Triangle
In which you use Sketchpad to explore the other side of the looking glass . . .
Presenter: Allow 20 minutes for the first two sections.
1. In a new sketch, use the Segment tool to draw a triangle on the left side of
the sketch window.
Holding down the
Shift key while you
draw helps keep the
segment vertical
(though it can still be
dragged any which
way later on).

2. Draw a vertical segment in the middle of your screen.
3. While this segment is still selected,
choose Mark Mirror from the Transform
menu. A brief animation indicates that
the segment has been marked as a mirror.
4. Select the whole triangle using a
Selection Rectangle.
5. With your triangle selected, choose
Reflect from the Transform menu.
A mirror image of your triangle
should appear on the other side of
your “mirror” segment.

Students enjoy
drawing stick figures
with the Segment
and Compass tools,
reflecting them
across a mirror line,
then dragging. You
might enjoy this
yourself!

6. Alter your original triangle. What happens to the mirror image? Move your
triangle around, make it bigger, smaller, move it closer to the mirror, further
away, across. Try to predict the associated movements of the image triangle.
What happens when you drag the image triangle? The mirror segment?
7. Draw a horizontal mirror and reflect both triangles across it. Explore and
predict the motions of the three image triangles when you change your
original triangle. Explore what happens when you change the relative
positions of the two mirror segments and make them nonperpendicular.

Dynamic Translations
8. Add a new, blank page to your document.
Holding down the
Shift key while
creating objects with
Toolbox tools keeps
previously selected
objects selected.

9. Construct a general quadrilateral interior. To do this,
choose the Point tool, then hold down the Shift key as you
click in four different spots in the sketch window. With the
four points selected, choose Quadrilateral Interior from the
Construct menu.
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A shortcut: Select
the interior and
choose Select
Parents from
the Edit menu.
Now choose
Segments from the
Construct menu.

10. Construct the four sides of your polygon.
11. Use the Segment tool to draw a segment in a blank area of the sketch plane.
Show the labels of the two endpoints of the new segment, then select them.
(Note the order of selection.)
12. Choose Mark Vector from the Transform menu. A brief animation from the
first selected point to the second selected point indicates that the vector has
been marked.
13. Select the sides and interior of your polygon. Choose Translate from the
Transform menu. The Translate dialog box appears. Click Translate to
translate by the marked vector.
14. Drag an endpoint of the segment defining the translation vector. What
happens to the translated image?
15. Select the translated sides and interior and translate them again by the
marked vector. (You won’t need to mark the vector again—just go straight
to the Translate command.) Do this several times in a row to get several
(five to eight) translated images.

A

B

Presenter: Stop here and answer questions. Allow 20 minutes for the next section. It’s a
very tricky section, so be ready to give extra support!

Tiling Parallelograms
Everyone’s human. What if you got to this point and realized, human that
you are, that you goofed, that you meant to make the original polygon a
parallelogram? Would
you have to start over?
Fortunately, thanks to
the Merge command,
you wouldn’t.
This is a good thing
to do when you think
a sketch may branch
out in different
directions. You can
even “import” a page
from one document
into another.

16. Add a duplicate of the
current page to your
document.
17. Drag point B so that the
images are quite spread
apart.
18. To turn your quadrilateral into a parallelogram, you’ll
only have to “redefine” one of its vertices—the other
three will remain unchanged. Pick which three should
remain as they are, then construct a new point to be the
fourth vertex of the parallelogram. (See the figure at right
for one approach involving two parallel lines.) Hide
everything new in this step but the point just constructed.
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19. Select the “other” quadrilateral vertex and the newly constructed point
(points 1 and 2 in the figure at step 18) and choose Merge Points from the
Edit menu. Use the Drag Test to confirm that your polygons are indeed
parallelograms no matter what.
Parallelograms are special in that they tile the plane. In other words, they can be
arranged in such a way that they fill the entire plane without overlaps or holes.
You’ll demonstrate this fact in the next section.
20. Drag objects until your sketch looks more or less like the figure below.
4

3

5
A

B

21. Mark a new vector from point 3 to point 4 (see the figure above).
22. Translate everything in the sketch (except sAB and its endpoints) by the
marked vector. Repeat several (five to eight) more times.
23. Drag point B until your
parallelograms indeed tile
the plane. How many such
locations are there for point B?
24. To fix your construction so that
the parallelograms always tile the
plane, no matter what is dragged,
merge point A to point 3, then merge point B to point 5.
Presenter: Stop here and answer questions.

Further Challenges
•

Do all quadrilaterals tile
the plane or just certain
special ones? Use Sketchpad
to explore this question.

•

Shapes that tile the plane can form
the basis of what might be called
an Escher-like tessellation. Study
the figure at right, then create
your own Escher-like tessellation.

Note: This activity was adapted from
a series of activities designed by John
Olive, Ph.D., University of Georgia,
Athens, Georgia, and was first used
at a workshop conducted at the International Conference on Technology in
Mathematics Teaching at the University
of Birmingham, England.
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Tour 6: A Sine Wave Tracer
One way to use Sketchpad in your courses is to have students work through
activities from one of the curriculum modules (see the inside back cover of this
booklet for the complete list). This tour introduces you to Sketchpad animation
as you work through an activity from the book Exploring Geometry with The
Geometer’s Sketchpad. The activity is reproduced verbatim, starting with “In this
exploration . . . ,” followed by a special extension section.
Presenter: Allow 20 minutes for the first section. Make sure to tell participants what they
should do with the questions (Q1, Q2, and so on). Mention that in the actual activity,
there is space after every question for written responses.
In this exploration, you’ll construct an animation “engine” that traces out a
special curve called a sine wave. Variations of sine curves are the graphs of
functions called periodic functions, functions that repeat themselves. The motion
of a pendulum and ocean tides are examples of periodic functions.
Sketch and Investigate
1. Construct a horizontal segment AB.
E
C
A

F
D
B

2. Construct a circle with center A and radius endpoint C.
3. Construct point D on sAB.
Select point D
and sAB; then, in
the Construct
menu, choose
Perpendicular Line.

4. Construct a line perpendicular to sAB through point D.
5. Construct point E on the circle.
6. Construct a line parallel to sAB through point E.
7. Construct point F, the point of intersection of the vertical line through point
D and the horizontal line through point E.

Don’t worry, this isn’t
a trick question!

Q1 Drag point D and describe what happens to point F.
Q2 Drag point E around the circle and describe what point F does.
Q3 In a minute, you’ll create an animation in your sketch that combines these
two motions. But first try to guess what the path of point F will be when
point D moves to the right along the segment at the same time that point E is
moving around the circle. Sketch the path you imagine below.
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Select points D and
E and choose Edit |
Action Buttons |
Animation. Choose
forward in the
Direction pop-up
menu for point D.

8. Make an action button that animates point D forward along sAB and
point E forward around the circle.
9. Move point D so that it’s just to the right of the circle.
10. Select point F; then, in the Display menu, choose Trace Intersection.
11. Press the Animation button.
Q4 In the space below, sketch the path traced by point F. Does the actual path
resemble your guess in Q3? How is it different?
12. Select the circle; then, in the Graph menu, choose Define Unit Circle. You
should get a graph with the origin at point A. Point B should lie on the xaxis. The y-coordinate of point F above sAB is the value of the sine of ∠EAD.
E
C

F
B

D
A

5

10

Q5 If the circle has a radius of 1 grid unit, what is its circumference in grid
units? (Calculate this yourself; don’t use Sketchpad to measure it because
Sketchpad will measure in inches or centimeters, not grid units.)
13. Measure the coordinates of point B.
14. Adjust the segment and the circle until you can make the curve trace back
on itself instead of drawing a new curve every time. (Keep point B on the
x-axis.)
Q6 What’s the relationship between the x-coordinate of point B and the
circumference of the circle (in grid units)? Explain why you think this is so.
Presenter: Stop here and answer questions. Discuss issues relating to using an activity
such as this in the classroom (for example, number of students per computer, written
versus oral responses to questions, and so on). Mention that most activities have an
“Explore More” section at the end—this activity is an exception.
Allow 15 minutes for the next section.
Extension: “Special Points”
The Exploring Geometry activity ends there. While it wasn’t designed to be a fullblown activity on unit circle trigonometry, you can nevertheless add a few things
that will lead in that direction. In the next section, you’ll add the right triangle
associated with point E and also add a new type of button—Movement buttons—
that will move point E to exact locations corresponding to angles of 30, 45, and
60 degrees.
15. Measure the coordinates of point E.
16. Construct the line through point E, perpendicular to the x-axis.
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Be careful not to
construct the
intersection of the
perpendicular and
sAB (since sAB is on
the x-axis). The
easiest way to be
certain is to select
the perpendicular
and the x-axis and
choose Intersection
from the Construct
menu.

17. Construct the intersection point of this
new line and the x-axis. Label the point G.
E

18. Construct the point at (1, 0) and label it H.
(You can either choose Plot Points from
the Graph menu or simply click on the
spot to get the point of intersection.)
19. Measure ∠HAE.

G

A

H

C

20. Hide the perpendicular line and construct
segments from A to E, from G to E, and from
A to G. Make these three segments thick and
red. This is your “reference triangle.”
Now you’ll create points on the circle at 30, 45, and 60 degrees. You’ll do this by
rotating point H about the origin, or A.
21. Double-click point A. This marks it as a center of rotation.
22. Select point H and choose Rotate from the Transform menu. Type 30 and
click Rotate.
23. Select point E and the new point in that order and choose Movement from
the Edit | Action Buttons submenu. Leave the speed at medium. On the
Label panel, change the label of the button to “30 degrees.”
24. Hide the new point (at 30 degrees), then press your button. Point E should
gracefully move around the circle until ∠HAE is 30 degrees.
25. Repeat steps 22 and 23 for 45 and 60 degrees.
Presenter: Stop here and answer questions. Discuss the differences between Animation
and Movement buttons.

Further Challenges
•

Add to your sketch so that the animation produces a cosine curve in addition
to the sine curve.

•

Trigonometry extension: How could you add a tangent curve?
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Tour 7: Investigating Rhombus Constructions
How many different ways are there to construct a rhombus in Sketchpad? A
challenge such as this can really deepen a student’s understanding of a shape’s
definition and properties. But how can you tell how a finished construction
works—how it was put together and how that relates to the properties in
question? In this tour, you’ll come up with several ways to construct a rhombus
and learn several methods of investigating other people’s constructions.

What You Will Learn
•

How to open a pre-made Sketchpad sketch

•

Five techniques for investigating someone
else’s sketch

•

What the Object Properties panel is and
how to use it to navigate the family tree

Five Investigation Techniques
Presenter: Allow 15 minutes for the first section. One place to find Rhombus.gsp is in
Samples | Teaching Mathematics. You may wish to move it for convenience.
1. Open the sketch Rhombus.gsp. (Your presenter will give you more detailed
instructions on where to find this file.)
2. Drag various parts of the figure. What can you deduce about the construction?
The five techniques
listed in this tour
aren’t in a strict
order. Which to use
depends on the
situation and your
preferences.

Dragging is the first technique for investigating a construction.
3. Choose Show All Hidden from the Display menu, then drag some more.
What can you now deduce about the construction?

Showing Hidden Objects is the second technique for investigating a
construction.

Holding down the
Shift key turns Undo
into Undo All and
Redo into Redo All.
A good idea here is
to Undo All, then
Redo step-by-step.

Another good technique for exploring constructions isn’t available to you here
because you opened a pre-made sketch. But when you check student work in a
classroom or lab, you can use the Undo command in the Edit menu (Ô+Z Mac,
Ctrl+Z Windows) to step back through a construction, then use the Redo
command (Ô+R Mac, Ctrl+R Windows) to replay the student’s steps.

Undoing/Redoing is the third technique for investigating a construction.
4. Select any one object in the
sketch and choose Properties
from the Edit menu. You’ll see
the Properties dialog box for
the selected object, open to the
Object panel. (Click on the
Object tab if it’s open to another
panel.) If necessary, drag the
dialog box by its title bar so
that it’s not obscuring the
construction.
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At the top of the panel is a geometric description of the object, usually in terms of
its parents (the objects that geometrically define the object). In the middle of the
panel are two pop-up menus—the Parents pop-up menu, listing the object’s
parents, and the Children pop-up menu, listing the object’s children (the objects
geometrically defined by the object).
5. Click and hold down the mouse button on the Parents pop-up menu. Drag
between the listed parents if there are more than one. Notice that the
highlighted object in the menu is also highlighted (selected) in the sketch
below. Release the mouse outside the pop-up menu to remain on the same
object’s Object panel. (Don’t worry, though, if you end up on a different
one.) Do the same thing for the Children pop-up menu.
You can also go
directly to any
object’s Object
Properties panel
by clicking on it in
the sketch.

6. Navigate the family tree. In other words, go to a different object’s Object
Properties panel by choosing it in the Parents or Children pop-up menu.
Read each object’s description at the top of the panel and think about how
objects relate to each other as parents and children. See if you can get to
every sketch object’s Object Properties panel through these pop-up menus.

Exploring Object Properties/Navigating the Family Tree is the fourth
Recall from Tour 4,
steps 14 and 15, that
you can select
objects in the sketch
to match the tool’s
givens and then walk
through the script
step-by-step.

technique for investigating a construction.
7. Select the entire figure and choose Create New Tool from the Custom Tools
menu (the bottom tool in the Toolbox). Name the tool whatever you’d like,
and click on Show Script View before clicking OK. (If you accidentally click
OK first, just choose Show Script View from the Custom Tools menu.) Read
through the script and see how it represents the construction.

Showing Script View is the fifth technique for investigating a construction.
Presenter: Stop here and answer questions. In particular, be sure to discuss the Object
Properties panel and navigating the family tree. Mention that different object types have
different Properties panels, and perhaps show some examples.
Allow as much time as you can for the next section. The more time, the more
constructions/investigations each participant will be able to do.

Sketch and Investigate
Now it’s your turn to create new rhombus constructions and investigate the
constructions of others.
8. Choose a partner.
To come up with new
constructions, it
helps to think about
a rhombus’s
properties, such as
the relationships
among its sides,
angles, and
diagonals, as well as
any symmetries
it exhibits.

9. On your own, come up with a construction for a rhombus that’s different
from the one you’ve been investigating. You’ll probably want to do this in
a new sketch or on a new page of Rhombus.gsp. When you’re done, hide
everything but the sides and vertices of the rhombus.
10. Switch computers and investigate your partner’s construction. Use at least
two or three of the investigation techniques listed. Your goal is not only to
understand how your partner’s construction works, but also to figure out
which properties of rhombuses it exploits.
11. Repeat steps 9 and 10, coming up with new rhombus constructions and
trying out investigation techniques you didn’t use previously. (Note that
any rhombus property can give rise to several different Sketchpad
constructions.)
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What Else Can This Thing Do?
You’ve still seen little more than a fraction of what Sketchpad can do. In fact, we
and others are finding things all the time that we’d never thought of doing with
Sketchpad! At this point you’ve gotten your feet wet using the program. You
might want to take a look at some of the sample sketches. Here’s a list of some
we like to show off in demonstrations, along with information you might find
helpful when you’re demonstrating the software.
Samples|Sketches|Geometry|Pythagoras.gsp: This sketch contains several
unusual and fascinating proofs of the famous theorem, using dissection,
shearing, and other methods.
Samples|Sketches|Algebra|Parametric Functions.gsp: This sketch includes
two fascinating parametric functions, one on a rectangular coordinate system
and one on a polar coordinate system. You can animate the parameter to trace
out the function, and you can modify the function itself.
Samples|Sketches|Trigonometry|Trigonometry Tracers.gsp: This sketch
includes constructions to trace out the sine and cosine, the tangent, and all six
trig functions at once.
Samples|Sketches|Conics|Unified Conics.gsp: This sketch includes the
locus of a parabola and an ellipse, and a construction that can be smoothly
transformed between ellipse, parabola, and hyperbola.
Samples|Sketches|Investigations|Poincare Disk.gsp: This sketch and set of
tools allows you to investigate all sorts of constructions using the Poincaré disk
model of non-Euclidean geometry.
Samples|Sketches|Advanced|Riemann Sums.gsp: This sketch shows the
upper, midpoint, and lower Riemann sums of a function on an interval. Modify
the number of subintervals, the limits of the interval, or the function itself.
Samples|Sketches|Investigations|Rainbow.gsp: This sketch demonstrates
how refraction of light within water droplets creates a rainbow.
Samples|Sketches|Fun|Sheep Dog.gsp: You control a sheep dog trying to
herd four sheep into a pen as the sheep try to wander off whenever you’re not
nipping at their heels.
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Sample Activities
The following sample activities show some of the ways Sketchpad can be used
to illuminate and explore topics from geometry and other areas of mathematics.
These activities come from a variety of Sketchpad curriculum modules and have
been chosen to show you a broad range of possible Sketchpad activities.
From Exploring Geometry with The Geometer’s Sketchpad
Properties of Reflection (page 24): Measure and investigate various reflected
images.
The Euler Segment (page 26): Which of the common circle center points are
collinear, and what other relationships exist?
From Exploring Algebra with The Geometer’s Sketchpad
Adding Integers (page 28): Model integers as vectors on a number line to
develop an intuitive understanding.
Points “Lining Up” in the Plane (page 31): Observe the patterns that result
when you move points so their coordinates satisfy certain conditions.
From Pythagoras Plugged In
Leonardo da Vinci’s Proof (page 34): Use rotation and reflection in
Leonardo’s proof of the Pythagorean Theorem.
From Exploring Conic Sections with The Geometer’s Sketchpad
The Folded Circle Construction (page 36): Use both physical and Sketchpad
models to construct conic sections.
From Rethinking Proof with The Geometer’s Sketchpad
Distances in an Equilateral Triangle (page 40): A shipwreck survivor helps
you prove a theorem about triangles.
Varignon Area (page 43): What’s the relationship between the area of an
inscribed quadrilateral and the original?
From Exploring Calculus with The Geometer’s Sketchpad
Going Off on a Tangent (page 46): Explore tangent lines of functions to
better understand derivatives.
Accumulating Area (page 49): Add up the area between a function and
the axis.
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Properties of Reflection

Name(s):

When you look at yourself in a mirror, how far away does your image in the
mirror appear to be? Why is it that your reflection looks just like you, but
backward? Reflections in geometry have some of the same properties of
reflections you observe in a mirror. In this activity, you’ll investigate the
properties of reflections that make a reflection the “mirror image” of the original.
Sketch and Investigate: Mirror Writing
1. Construct vertical
line dAB.

A

2. Construct point C to
the right of the line.
Double-click on
the line.

3. Mark dAB as a mirror.
C

C'

4. Reflect point C to
construct point C´.
Select the two
points; then, in the
Display menu,
choose Trace
Points. A check
mark indicates that
the command is
turned on. Choose
Erase Traces to
erase your traces.

B

5. Turn on Trace Points
for points C and C´.
6. Drag point C so that it traces out your name.
Q1 What does point C´ trace?

7. For a real challenge, try dragging point C´ so that point C traces out
your name.
Sketch and Investigate: Reflecting Geometric Figures
Select points C and
C´. In the Display
menu, you’ll see
Trace Points
checked. Choose it
to uncheck it.

8. Turn off Trace Points for
points C and C´.

D

E

B

D'

9. In the Display menu, choose
Erase Traces.
10. Construct jCDE.

Select the entire
figure; then, in the
Transform menu,
choose Reflect.

E'

11. Reflect jCDE (sides and
vertices) over AB.
d
C

12. Drag different parts of either
triangle and observe how the
triangles are related. Also drag
the mirror line.

A
C'

13. Measure the lengths of the sides of jCDE and jC´D´E´.
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Select three points
that name the angle,
with the vertex your
middle selection.
Then, in the
Measure menu,
choose Angle.

Q2 Measure one angle in jCDE and measure the corresponding angle in
jC´D´E´. What effect does reflection have on lengths and angle measures?

Q3 Are a figure and its mirror image always congruent? State your answer as a
conjecture.

Your answer to
Q4 demonstrates
that a reflection
reverses the
orientation of
a figure.

Line Weight is in the
Display menu.

You may wish to
construct points of
intersection and
measure distances
to look for
relationships
between the mirror
line and the dashed
segments.

Q4 Going alphabetically from C to D to E in jCDE, are the vertices oriented in
a clockwise or counter-clockwise direction? In what direction (clockwise or
counter-clockwise) are vertices C´, D´, and E´ oriented in the reflected
triangle?

14. Construct segments connecting
each point and its image: C to C´,
D to D´, and E to E´. Make these
segments dashed.

D

B

E

Q5 Drag different parts of the sketch
around and observe relationships between
the dashed segments and the mirror line.
How is the mirror line related to a segment
connecting a point and its reflected image?

D'

E'
C
A

C'

Explore More
1. Suppose Sketchpad didn’t have a Transform menu. How could you
construct a given point’s mirror image over a given line? Try it. Start with a
point and a line. Come up with a construction for the reflection of the point
over the line using just the tools and the Construct menu. Describe your
method.
2. Use a reflection to construct an isosceles triangle. Explain what you did.
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The Euler Segment

Name(s):

In this investigation, you’ll look for a relationship among four points of
concurrency: the incenter, the circumcenter, the orthocenter, and the centroid.
You’ll use custom tools to construct these triangle centers, either those you made
in previous investigations or pre-made tools.
Sketch and Investigate
Triangle
Centers.gsp can be
found in Sketchpad |
Samples | Custom
Tools. (Sketchpad
is the folder that
contains the
application itself.)

1. Open a sketch of yours that contains
tools for the triangle centers: incenter,
circumcenter, orthocenter, and centroid.
Or, open Triangle Centers.gsp.

I

2. Construct a triangle.
3. Use the Incenter tool on the triangle’s vertices
to construct its incenter.
4. If necessary, give the incenter a label that identifies it, such as I for incenter.
5. You need only the triangle and the incenter for now, so hide anything extra
that your custom tool may have constructed (such as angle bisectors or the
incircle).
6. Use the Circumcenter tool on the
same triangle. Hide any extras
so that you have just the triangle,
its incenter, and its circumcenter.
If necessary, give the circumcenter
a label that identifies it.

I
O

Ce

Ci

7. Use the Orthocenter tool on the
same triangle, hide any extras,
and label the orthocenter.
8. Use the Centroid tool on the same triangle, hide extras, and label the
centroid. You should now have a triangle and the four triangle centers.
Q1 Drag your triangle around and observe how the points behave. Three of the
four points are always collinear. Which ones?

9. Construct a segment that contains the three collinear points. This is called
the Euler segment.
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Q2 Drag the triangle again and look for interesting relationships on the Euler
segment. Be sure to check special triangles, such as isosceles and right
triangles. Describe any special triangles in which the triangle centers are
related in interesting ways or located in interesting places.

Q3 Which of the three points are always endpoints of the Euler segment and
which point is always between them?

To measure the
distance between
two points, select the
two points. Then, in
the Measure menu,
choose Distance.
(Measuring the
distance between
points is an easy
way to measure
the length of part
of a segment.)

10. Measure the distances along the two parts of the Euler segment.
Q4 Drag the triangle and look for a relationship between these lengths. How
are the lengths of the two parts of the Euler segment related? Test your
conjecture using the Calculator.

Explore More
1. Construct a circle centered at the midpoint of the Euler segment and passing
through the midpoint of one of the sides of the triangle. This circle is called
the nine-point circle. The midpoint it passes through is one of the nine points.
What are the other eight? (Hint: Six of them have to do with the altitudes
and the orthocenter.)
2. Once you’ve constructed the nine-point circle as described above, drag your
triangle around and investigate special triangles. Describe any triangles in
which some of the nine points coincide.
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Adding Integers
Definition: Integers
are positive and
negative whole
numbers, including
zero. On a number
line, tick marks
usually represent
the integers.
All sketches referred
to in this booklet
can be found in
Sketchpad |
Samples | Teaching
Mathematics
(Sketchpad is the
folder that contains
the application itself.)

Name(s):

They say that a picture is worth a thousand words. In the next two activities,
you’ll explore integer addition and subtraction using a visual Sketchpad model.
Keeping this model in mind can help you visualize what these operations do and
how they work.
Sketch and Investigate
1. Open the sketch Add
Integers.gsp.
2. Study the problem that’s
modeled: 8 + 5 = 13. Then
drag the two “drag” circles
to model other addition
problems. Notice how the
two upper arrows relate to
the two lower arrows.

8

drag

+ 5

-1

0

Q1 Model the problem – 6 + – 3. According
to your sketch, what is the sum of – 6
and – 3?

drag

1

2

3

4

5

10

-6

drag

+ -3

drag

-5

-4

-3

-2

-1

0

1

3. Model three more problems in which you add two negative numbers. Write
your equations (“– 2 + – 2 = – 4,” for example) below.

Q2 How is adding two negative numbers similar to adding two positive
numbers? How is it different?

Q3 Is it possible to add two negative numbers and get a positive sum? Explain.
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Q4 Model the problem 5 + – 5.
According to your sketch,
what is the sum of 5 and – 5?

5
+ -5

drag

-5

drag

-4

-3

-2

-1

0

1

2

3

4

5

4. Model four more problems in which the sum is zero. Have the first number
be positive in two problems and negative in two problems. Write your
equations below.

Q5 What must be true about two numbers if their sum is zero?

Q6 Model the problem 4 + – 7.
According to your sketch,
what is the sum of 4 and – 7?

4

drag

+ -7

drag

-5

-4

-3

-2

-1

0

1

2

3

4

5

5. Model six more problems in which you add one positive number and one
negative number. Have the first number be positive in three problems and
negative in three. Also, make sure that some problems have positive
answers and others have negative answers. Write your equations below.

Q7 When adding a positive number and a negative number, how can you tell if
the answer will be positive or negative?
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Q8 A classmate says, “Adding a positive number and a negative number seems
more like subtracting.” Explain what she means.

Q9 Fill in the blanks.
a. The sum of a positive number and a positive number is always a
number.
b. The sum of a negative number and a negative number is always a
number.
c. The sum of any number and

is always zero.

d. The sum of a negative number and a positive number is
if the positive number is larger and
number is larger. (“Larger” here means farther from zero.)

if the negative

Explore More
To commute
means to travel
back and forth.
The Commutative
Property of Addition
basically says that
addends can
commute across an
addition sign without
affecting the sum.

1. The Commutative Property of Addition says that for any two numbers a and b,
a + b = b + a. In other words, order doesn’t matter in addition! Model two
addition problems on your sketch’s number line that demonstrate this
property.
a. Given the way addition is represented in this activity, why does the
Commutative Property of Addition make sense?
b. Does the Commutative Property of Addition work if one or both addends
are negative? Give examples to support your answer.

30 • The Geometer’s Sketchpad Workshop Guide

© 2002 Key Curriculum Press

Points “Lining Up” in the Plane

Name(s):

If you’ve seen marching bands perform at football games, you’ve probably seen
the following: The band members, wandering in seemingly random directions,
suddenly spell a word or form a cool picture. Can these patterns be described
mathematically? In this activity, you’ll start to answer this question by exploring
simple patterns of dots in the x-y plane.
Sketch and Investigate
1. Open a new sketch.
Holding down the
Shift key keeps all
five points selected.

To measure
the coordinates
of selected
points, choose
Coordinates from
the Measure menu.

To hide objects,
select them and
choose Hide from
the Display menu.

2. Choose the Point tool from the Toolbox. Then, while holding down the Shift
key, click five times in different locations (other than on the axes) to
construct five new points.
3. Measure the coordinates of the
five selected points.

A: (3.00, 3.00)
B: (-1.00, -1.00)

A

C: (2.00, -2.00)

A coordinate system appears and
the coordinates of the five points
are displayed.

2

D: (3.00, -1.00)

E

E: (1.00, 2.00)

4. Hide the points at (0, 0) and
at (1, 0).

B

D
-2

5. Choose Snap Points from the
Graph menu.

C

From now on, the points will only land
on locations with integer coordinates.
Q1 For each problem, drag the five points to different locations that satisfy the
given conditions. Then copy your solutions onto the grids on the next page.
For each point,
a. the y-coordinate equals the x-coordinate.
b. the y-coordinate is one greater than the x-coordinate.
c. the y-coordinate is twice the x-coordinate.
d. the y-coordinate is one greater than twice the x-coordinate.
The absolute value
of a number is its
“positive value.”
The absolute
value of both
5 and –5 is 5.

e. the y-coordinate is the opposite of the x-coordinate.
f.

the sum of the x- and y-coordinates is five.

g. the y-coordinate is the absolute value of the x-coordinate.
h. the y-coordinate is the square of the x-coordinate.
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a.

-10

b.
6

6

3

3

-5

5

10

-3

-6

-6

6

6

3

3

-5

5

10

-10

-5

-3

-3

-6

-6

10

5

10

5

10

5

10

f.
6

6

3

3

-5

5

10

-10

-5

-3

-3

-6

-6

g.

-10

5

d.

e.

-10

-5

-3

c.

-10

-10

h.
6

6

3

3

-5

5

10

-10

-5

-3

-3

-6

-6
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Backward Thinking
In Q1, you were given descriptions and asked to apply them to points. Here,
we’ll reverse the process and let you play detective.
All sketches referred
to in this booklet
can be found in
Sketchpad |
Samples | Teaching
Mathematics
(Sketchpad is the
folder that contains
the application itself.)

6. Open the sketch Line Up.gsp.
You’ll see a coordinate system with eight points (A through H), their coordinate
measurements, and eight action buttons.
Q2 For each letter, press the corresponding button in the sketch. Like the
members of a marching band, the points will “wander” until they form a
pattern. Study the coordinates of the points in each pattern, then write a
description (like the ones in Q1) for each one.
a.
b.
c.
d.
e.
f.
g.
h.
Explore More
1. Each of the “descriptions” in this activity can be written as an equation.
For example, part b of Q1 (“the y-coordinate is one greater than the
x-coordinate”) can be written as y = x + 1. Write an equation for each
description in Q1 and Q2.
2. Add your own action buttons to those in Line Up.gsp, then see if
your classmates can come up with descriptions or equations for your
patterns. Instructions on how to do this are on page 2 of the sketch.
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Leonardo da Vinci’s Proof

Name(s):

Leonardo da Vinci (1452–1519) was a great Italian painter, engineer, and inventor
during the Renaissance. He is most famous, perhaps, for his painting Mona Lisa.
He is also credited with the following proof of the Pythagorean theorem.
Construct
In this figure, you
don’t have to
construct the square
on the hypotenuse.

1. Construct a right triangle and squares on the legs.
2. Connect corners of the squares to construct a second right triangle
congruent to the original.
3. Construct a segment through the center of this figure, connecting far corners
of the squares and passing through C.
4. Construct the midpoint, H, of this segment.

The Action Buttons
submenu is in
the Edit menu.

5. This segment divides the figure into mirror image halves. Select all the
segments and points on one side of the center line and create a Hide/Show
action button. Change its label to read “Hide reflection.”
B
a

c
b

a

c

A

C

H

b

Hide reflection

6. Press the Hide reflection action button. You should now see half the figure.
B
a

c
b

C

A
H

Show reflection

7. Mark H as center and rotate the entire figure (not the action buttons) by
180° about H.
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8. Select all the objects making up the rotated half of this figure and create a
Hide/Show action button. Relabel this button to read “Hide rotation,” but
don’t hide the rotated half yet.
a

B
c

a

b

b

A

C
H

C'

A'

B'

Show reflection
Hide rotation

9. Construct xA′ B and xB′A. Do you see
c squared?

a

B
c

a

10. Construct the polygon interior of BA´B´A
and of the two triangles adjacent to it.
11. Select xA′ B, xB′A, and the three polygon
interiors and create a Hide/Show action
button. Name it “Hide c squared.”

b

c

b
A

C
H

C'

A'

B'

Show reflection
Hide rotation
Hide c squared

Investigate
From going through this construction, you may have a good idea of how
Leonardo’s proof goes. Press all the hide buttons, then play through the
buttons in this sequence: Show reflection, Show rotation, Hide reflection, Show c
squared. You should see the transformation from two right triangles with squares
on the legs into two identical right triangles with a square on their hypotenuses.
Explain to a classmate or make a presentation to the class to explain Leonardo’s
proof of the Pythagorean theorem.
Prove
Leonardo’s is another of those elegant proofs where the figure tells pretty much
the whole story. Write a paragraph that explains why the two hexagons have
equal areas and how these equal hexagons prove the Pythagorean theorem.
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The Folded Circle Construction

Name(s):

Sometimes a conic section appears in the unlikeliest of places. In this activity,
you’ll explore a paper-folding construction in which crease lines interact in a
surprising way to form a conic.
Constructing a Physical Model
Preparation: Use a compass to draw a circle with a radius of approximately three inches
on a piece of wax paper or patty paper. Cut out the circle with a pair of scissors. (If you
don’t have these materials, you can draw the circle in Sketchpad and print it.)
1. Mark point A, the center of your circle.
If you’re working
in a class, have
members place B at
different distances
from the center.
If you’re working
alone, do this section
twice—once with B
close to the center,
once with B close
to the edge.

2. Mark a random point B within the
interior of your circle.
3. As shown below right, fold
the circle so that a point on its
circumference lands directly onto
point B. Make a sharp crease to
keep a record of this fold.
Unfold the circle.

B
A

4. Fold the circle along a new crease so that a
different point on the circumference lands on
point B. Unfold the circle and repeat the process.
5. After you’ve made a dozen or so creases, examine
them to see if you spot any emerging patterns.
Mathematicians
would describe
your set of creases
as an envelope
of creases.

6. Resume creasing your circle. Gradually,
a well-outlined curve will appear. Be
patient—it may take a little while.

B
A

7. Discuss what you see with your
classmates and compare their folded
curves to yours. If you’re doing this
activity alone, fold a second circle with
point B in a different location.
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Questions
Q1 The creases on your circle seem to form the outline of an ellipse. What
appear to be its focal points?
Q2 If you were to move point B closer to the edge of the circle and fold another
curve, how do you think its shape would compare to the first curve?
Q3 If you were to move point B closer to the center of the circle and fold another
curve, how do you think its shape would compare to the first curve?
Constructing a Sketchpad Model
Fold and unfold. Fold and unfold. Creasing your circle takes some work. Folding
one or two sheets is fun, but what would happen if you wanted to continue
testing different locations for point B? You’d need to keep starting with fresh
circles, folding new sets of creases.
Sketchpad can streamline your work. With just one circle and one set of creases,
you can drag point B to new locations and watch the crease lines adjust
themselves instantaneously.
8. Open a new sketch and use the
Compass tool to draw a large circle
with center A. Hide the circle’s
radius point.
9. Use the Point tool to draw
a point B at a random spot
inside the circle.

C

B
A
crease

10. Construct a point C on the
circle’s circumference.
11. Construct the “crease” formed when
point C is folded onto point B.
12. Drag point C around the circle. If you constructed your crease line correctly,
it should adjust to the new locations of point C.
13. Select the crease line and choose Trace Line from the Display menu.
If you don’t want
your traces to fade,
be sure the Fade
Traces Over Time
box is unchecked
on the Color panel
of the Preferences
dialog box.

14. Drag point C around the circle to create a collection of crease lines.
15. Drag point B to a different location and then, if necessary, choose Erase
Traces from the Display menu.
16. Drag point C around the circle to create another collection of
crease lines.
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Retracing creases for each location of point B is certainly faster than folding
new circles. But we can do better. Ideally, your crease lines should relocate
automatically as you drag point B. Sketchpad’s powerful Locus command
makes this possible.
17. Turn tracing off for your original crease line by selecting it and once again
choosing Trace Line from the Display menu.
18. Now select your crease line and point C. Choose Locus from the Construct
menu. An entire set of creases will appear: the locus of crease locations as
point C moves along its path. If you drag point B, you’ll see that the crease
lines readjust automatically.
19. Save your sketch for possible future use. Give it a descriptive name such as
Creased Circle.

Questions
Q4 How does the shape of the curve change as you move point B closer to the
edge of the circle?
Q5 How does the shape of the curve change as you move point B closer to the
center of the circle?
The Merge and Split
commands appear
in the Edit menu.

Q6 Select point B and the circle. Then merge point B onto the circle’s
circumference. Describe the crease pattern.
Q7 Select point B and split it from the circle’s circumference. Then merge it with
the circle’s center. Describe the crease pattern.
Playing Detective
Each crease line on your circle touches the ellipse at exactly one point. Another
way of saying this is that each crease is tangent to the ellipse. By engaging in
some detective work, you can locate these tangency points and use them to
construct just the ellipse without its creases.

All sketches referred
to in this booklet
can be found in
Sketchpad |
Samples | Teaching
Mathematics
(Sketchpad is the
folder that contains
the application itself.)

Select the locus
and make its width
thicker so that it’s
easier to see.

20. Open the sketch Folded Circle.gsp. You’ll see a thick crease line and its
locus already in place.
21. Drag point C and notice that the crease line remains tangent to the ellipse.
The exact point of tangency lies at the intersection of two lines—the crease
line and another line not shown in the figure on the next page. Construct this
other line in your sketch as well as the point of tangency, point E.
22. Select point E and point C and choose Locus from the Construct menu.
If you’ve identified the tangency point correctly, you should see a curve
appear precisely in the white space bordered by the creases.
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How to Prove It
The Folded Circle construction
seems to generate ellipses. Can
you prove that it does? Try
developing a proof on your
own, or work through the
following steps and questions.
The picture at right should
resemble your construction.
d HI (the perpendicular bisector
of sCB) represents the crease
formed when point C is folded
onto point B. Point E sits on the
curve itself.

C

I

E
B
A

H

23. Add segments sCB, sBE, and sAC to
the picture.
24. Label the intersection of sCB with the crease line as point D.

Questions
Q8 Use a triangle congruence theorem to prove that jBED m j
CED.
Q9 sBE is equal in length to which other segment? Why?
Remember: An
ellipse is the set
of points such
that the sum of the
distances from each
point to two fixed
points (the foci)
is constant.

Q10 Use the distance definition of an ellipse and the result from Q9 to prove that
point E traces an ellipse.
Explore More
1. When point B lies within its circle, the creases outline an ellipse. What
happens when point B lies outside its circle?
2. Use the illustration from your ellipse proof to show that ∠AEH

m∠
BED.

Here’s an interesting consequence of this result: Imagine a pool table in the shape
of an ellipse with a hole at one of its focal points. If you place a ball on the other
focal point and hit it in any direction without spin, the ball will bounce off the
side and go straight into the hole. Guaranteed!
3. The sketch Tangent Circles.gsp in the Ellipse folder shows a red circle c3
that’s simultaneously tangent to circles c1 and c2. Press the Animate button
and observe the path of point C, the center of circle c3. Can you prove that
C traces an ellipse?
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Distances in an
Equilateral Triangle

Name(s):

C
A shipwreck survivor manages to swim to a desert island.
As it happens, the island closely approximates the shape
of an equilateral triangle. She soon discovers that the
surfing is outstanding on all three of the island’s coasts.
She crafts a surfboard from a fallen tree and surfs every
day. Where should she build her house so that the sum
A
of the distances from her house to all three beaches is
as small as possible? (She visits each beach with equal
frequency.) Before you proceed further, locate a point in the triangle at the spot
where you think she should build her house.

B

Conjecture
All sketches referred
to in this booklet
can be found in
Sketchpad |
Samples | Teaching
Mathematics
(Sketchpad is the
folder that contains
the application itself.)

1. Open the sketch Distance.gsp. Drag point P to experiment with your sketch.
Q1 Press the button to show the distance sum. Drag point P around the interior
of the triangle. What do you notice about the sum of the distances?

Q2 Drag a vertex of the triangle to change the triangle’s size. Again, drag point
P around the interior of the triangle. What do you notice now?

Q3 What happens if you drag P outside the triangle?

Q4 Organize your observations from Q1– Q3 into a conjecture. Write your
conjecture using complete sentences.
Explaining
You are no doubt convinced that the total sum of the
distances from point P to all three sides of a given
equilateral triangle is always constant, as long as P is
an interior point. But can you explain why this is true?

a
h3

h1
P

h2

Although further exploration in Sketchpad might
a
succeed in convincing you even more fully of the
truth of your conjecture, it would only confirm the
a
conjecture’s truth without providing an explanation.
For example, the observation that the sun rises every
morning does not explain why this is true. We have to
try to explain it in terms of something else, for example, the rotation of the earth
around the polar axis.
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Recently, a mathematician named Mitchell Feigenbaum made some experimental
discoveries in fractal geometry using a computer, just as you have used
Sketchpad to discover your conjecture about a point inside an equilateral
triangle. Feigenbaum’s discoveries were later explained by Lanford and others.
Here’s what another mathematician had to say about all this:
Lanford and other mathematicians were not trying to validate
Feigenbaum’s results any more than, say, Newton was trying to
validate the discoveries of Kepler on the planetary orbits. In both
cases the validity of the results was never in question. What was
missing was the explanation. Why were the orbits ellipses? Why
did they satisfy these particular relations? . . . there’s a world of
difference between validating and explaining.
—M. D. Gale (1990), in
The Mathematical Intelligencer, 12(1), 4.
Challenge
Use another sheet of paper to try to logically explain your conjecture from Q4.
After you have thought for a while and made some notes, use the balance of this
activity to develop an explanation of your conjectures.
2. Press the button to show the small triangles in your sketch.
Q5 Drag a vertex of the original triangle. Why are the three different sides
all labeled a?

Q6 Write an expression for the area of each small triangle using a and the
variables h1, h2, and h3.

Q7 Add the three areas and simplify your expression by taking out any
common factors.

Q8 How is the sum in Q7 related to the total area of the equilateral triangle?
Write an equation to show this relationship using A for the area of the
equilateral triangle.

Q9 Use your equation from Q8 to explain why the sum of the distances
to all three sides of a given equilateral triangle is always constant.
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Q10 Drag P to a vertex point. How is the sum of the distances related to the
altitude of the original triangle in this case?

Q11 Explain why your explanations in Q5 – Q9 would not work if the triangle
were not equilateral.

Present Your Explanation
Summarize your explanation of your original conjecture. You can use Q5–Q11 to
help you. You might write your explanation as an argument in paragraph form
or as a two-column proof. Use the back of this page, another sheet of paper, a
Sketchpad sketch, or some other medium.
Further Exploration
1. Construct any ∆ABC and an arbitrary point P inside it. Where should
you locate P to minimize the sum of the distances to all three sides of
the triangle?
2. a. Construct any rhombus and an arbitrary point P inside it. Where
should you locate P to minimize the sum of the distances to all four
sides of the rhombus?
b. Explain your observation in 2a and generalize to polygons with a
similar property.
3. a. Construct any parallelogram and an arbitrary point P inside it. Where
should you locate P to minimize the sum of the distances to all four sides
of the parallelogram?
b. Explain your observation in 3a and generalize to polygons with a
similar property.
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Varignon Area

Name(s):

In this activity, you will compare the area of a quadrilateral to the area of another
quadrilateral constructed inside it.
Conjecture
All sketches referred
to in this booklet
can be found in
Sketchpad |
Samples | Teaching
Mathematics
(Sketchpad is the
folder that contains
the application itself.)

1. Open the sketch Varignon.gsp and drag
vertices to investigate the shapes.
Q1 Points E, F, G, and H are midpoints of
the sides of quadrilateral ABCD. Describe
polygon EFGH.

C

F

B
E

G

A

H

D

2. Press the appropriate button to show the areas of the two quadrilaterals.
Drag a vertex and observe the areas.
Q2 Describe how the areas are related. You might want to find their ratio.

Q3 Drag any of the points A, B, C, and D and observe the two area
measurements. Does the ratio between them change?

Q4 Drag a vertex of ABCD until it is concave.
Does this change the ratio of the areas?

B
E

Q5 Write your discoveries so far as one or
more conjectures. Use complete sentences.

F
C

A

G
H

D

Q6 You probably can think of times when something that appeared to be always
true turned out to be false on occasion. How certain are you that your
conjecture is always true? Record your level of certainty on the number line
and explain your choice.

0%
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25%

50%

75%

100%
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Challenge
If you believe your conjecture is always true, provide some examples to support
your view and try to convince your partner or members of your group. Even
better, support your conjecture with a logical explanation or a convincing proof.
If you suspect your conjecture is not always true, try to supply counterexamples.
Proving
You probably observed that quadrilateral EFGH is a parallelogram. You also
probably made a conjecture that goes something like this: The area of the
parallelogram formed by connecting the midpoints of the sides of a quadrilateral
is half the area of the quadrilateral.
This first conjecture about quadrilateral EFGH matches a theorem of geometry
that is sometimes called Varignon’s theorem. Pierre Varignon was a priest and
mathematician born in 1654 in Caen, France. He is known for his work with
calculus and mechanics, including discoveries that relate to fluid flow and
water clocks.
The next three questions will help you verify that quadrilateral EFGH is a
parallelogram. If you have verified this before, skip to Q10.
Q7 Construct diagonal sAC. How are sEF
and sHG related to sAC? Why?

B

F

C

E
G

Q8 Construct diagonal sBD. How are sEH
and sFG related to sBD? Why?

A

H

D

Q9 Use Q7 and Q8 to explain why EFGH must
be a parallelogram.
Work through the questions that follow for one
possible explanation as to why parallelogram
EFGH has half the area of quadrilateral ABCD.
(If you have constructed diagonals in ABCD,
it will help to delete or hide them.)

B
F

E

C
A
H

G
D

Q10 Assume for now that ABCD is convex.
One way to explain why ABCD has twice the
area of EFGH is to look at the regions that are inside ABCD but not inside
EFGH. Describe these regions.

Q11 According to your conjecture, how should the total area of the regions you
described in Q10 compare to the area of EFGH?
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B

3. Press the button to translate the midpoint
quadrilateral EFGH along vector EF.
Q12 Drag any point. How does the area of the
translated quadrilateral compare to the
area of EFGH?

F'

F

E

C

A
H

G

G'

F

F'

D

4. Construct xF′ C and xG′ C.

B

Q13 How is jEBF related to jF′ CF?

Q14 Explain why the relationship you
described in Q13 must be true.

E

C

A
G

H

G'

D

Q15 How is jHDG related to jG′ CG?

Q16 Explain why the relationship you described in Q15 must be true.

Q17 How is jAEH related to jCF′ G′ ?

Q18 Explain why the relationship you described in Q17 must be true.

Q19 You have one more triangle to account for. Explain how this last triangle fits
into your explanation.

Present Your Proof
Create a summary of your explanations from Q10 – Q19. This summary, your
proof, may be in paper form or electronic form and may include a presentation
sketch in Sketchpad. You may want to discuss your proof with your partner
or group.
Further Exploration
Which part of your proof does not work for concave quadrilaterals? Try to redo
the proof so that it explains the concave case as well. (Hint: Drag point C until
quadrilateral ABCD is concave.)
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Going Off on a Tangent

Name(s):

4
You can see what the average rate of change
between two points on a function looks like—
2
it’s the slope of the secant line between the two
points. You have also learned that as one point
Q
approaches the other, average rate approaches
2
P
instantaneous rate (provided that the limit
-2
y=f(x)
exists). But what does instantaneous rate look
like? In this activity you will get more acquainted
with the derivative and learn how to see it in the slope of a very special line.

Sketch and Investigate
All sketches referred
to in this booklet
can be found in
Sketchpad |
Samples | Teaching
Mathematics
(Sketchpad is the
folder that contains
the application itself.)

1. Open the sketch Tangents.gsp.
In this sketch there is a function plotted and a line that intersects the function at a
point P. This new line is called the tangent line because it intersects the function
only once in the region near point P. Its slope is the instantaneous rate of change—
or derivative—at point P:
tangent’s slope = instantaneous rate at P = f ′ (xP)
So how do you find this line? Let’s hold off on that for a bit and look at the line’s
slope—the derivative—and see how it behaves. Remember, slope is the key!

Be careful here—the
grid is not square!

Q1 Move point P as close as possible to x = –1. Without using the calculator,
estimate f ′ (–1)—the derivative of f at x = –1. (Hint: What’s the slope of the
tangent line at x = –1?)
Q2 Move point P as close as possible to x = 0. Without using the calculator,
estimate f ′ (0)—the derivative of f at x = 0. (Hint: See the previous hint!)
Q3 Move point P as close as possible to x = 1. Without using the calculator,
estimate f ′ (1)—the derivative of f at x = 1. (Sorry, no hint this time.)

If you’d like, you can
animate point P by
selecting it, then
choosing Animate
Point from the
Display menu.

2. Move point P back to about x = –1. Drag
point P slowly along the function f from left
to right. Watch the line’s slope carefully so
that you can answer some questions.
Q4 For what x-values is the derivative positive?
(Hint: When is the slope of the tangent line
positive?) What can you say about the curve
where the derivative is positive?

P

y=f(x)

Q5 For what x-values is the derivative negative? (Hint: Look at the hint in Q4
and make up your own hint.) What can you say about the curve where the
derivative is negative?
Q6 For what x-values does the derivative equal zero? What can you say about
the curve where the derivative is zero?
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Q7 For what value or values of x on the interval from –1 to 3 is the slope of the
tangent line the steepest (either positive or negative)? How would you
translate this question into the language of derivatives?
3. Go to page 2 of the document. Here the function is f (x) = 4 sin(x).
If you want to
recenter your sketch,
select the origin and
move it to the
desired location.

4. Press the Show Zoom Tools button and use the xscale slider to change your window to go from
–2π to 2π on the x-axis. (You can hide the tools
again by pressing the Hide Zoom Tools button.)

5

P
y=f(x)

5. Move point P so that its x-coordinate is around
x = – 6.

5

6. Move point P slowly along the function to the
right until you get to about x = 6. As you move
the point, watch the tangent line’s slope so you
can answer the following questions.

f(x) = 4⋅⋅sin(x)

Q8 Answer Q4 – Q7 for this function. Could you have relied on physical features
of the graph to answer these questions quickly? (In other words, could you
have answered Q4 – Q7 for this function without moving point P?)
There is an interesting relationship between how the slope is increasing or
decreasing and whether the tangent line is above or below the curve. Move
point P slowly from left to right again on the function, comparing the steepness
of the line to its location—above or below the curve.
Q9 When is the slope of the line increasing? Is the tangent line above or below
the function when the slope is increasing?
Q10 When is the slope of the line decreasing? Is the tangent line above or below
the function when the slope is decreasing?
Q11 Write your conclusion for the relationship between the slope of the tangent
line and its location above or below the curve. How would you translate this
into a relationship between the derivative and the function’s concavity?
Let’s check whether or not your conclusion is really true. The derivative is the
slope of the tangent line, so an easy way to check is to calculate the slope of
the line.
7. Select the tangent line and measure its slope by choosing Slope from the
Measure menu. Label it TangentSlope.
8. Move point P slowly along the
function again from left to right
and watch the values of the
measurement TangentSlope.

TangentSlope = 1.34277
f(x) = 4⋅⋅sin(x)

P

Q12 Do your answers to Q9 – Q10
hold up?

y=f(x)

-5
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Explore More
Each of the following functions has some interesting problems or characteristics.
For each one, change the equation for f (x) by double-clicking on the expression
for f (x) and entering in the new expression. Then answer the questions below. If
you need to zoom in at a point, press the Show Zoom Tools button. Remember that
(a, b) represents the point you will zoom in on. To change a or b, double-click on
the parameter and enter a new value.

f1 ( x) = x − 2

f 2 ( x) = x 2 − 6 x + 8
f 3 ( x) = x − 1
Q1 Where does the derivative not exist for f1(x) and why? (What happens to the
tangent line at that point?)
Q2 Answer Q1 for f 2 ( x) = x 2 − 6 x + 8 .
Q3 Answer Q1 for f 3 ( x) =

x − 1.

Q4 How is the function f1 ( x) = x − 2 different from all the others that you
have looked at in this activity, including f 2 and f 3?
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Accumulating Area

Name(s):

How would you describe the shaded region
shown here? You could say: The shaded
region is the area between the x-axis and
the curve f (x) on the interval 0 ≤ x ≤ 4. Or,
if you didn’t want to use all those words,
you could say: The shaded region is
4

∫0

f or

4

∫0

f ( x) dx

1

y=f(x)
0.5

2

4

-0.5

which is much faster to write!
In general, the notation

b

∫a

f ( x) dx represents the signed area between the curve f

and the x-axis on the interval a ≤ x ≤ b. This means that the area below the x-axis
is counted as negative. This activity will acquaint you with this notation, which is
called the integral, and help you translate it into the signed area it represents.
Sketch and Investigate
All sketches referred
to in this booklet
can be found in
Sketchpad |
Samples | Teaching
Mathematics
(Sketchpad is the
folder that contains
the application itself.)

1. Open the document Area2.gsp. You have a function f composed of some line
segments and a semicircle connected by moveable points.
If you need to evaluate the integral

4

∫0

f ( x) dx , the

first step is to translate it into the language of areas.
This integral stands for the area between f and the
x-axis from x = 0 to x = 4, as shown. This area is easy
to find—you have a quarter-circle on 0 ≤ x ≤ 2 and a
right triangle on 2 ≤ x ≤ 4.

D

6

4

2

y=f(x)

So on [0, 2] you have
2

∫0

f ( x) dx = 0.25πr 2 = 0.25π( 2) 2 = π

C

5

and on [2, 4] you have
4

∫2
so

∫

4

0

f ( x) dx = 0.5( base)( height ) = 0.5( 2)(6) = 6

f ( x) dx = 6 + π

2. To check this with the Area tools, press the Show Area Tools button.
There are three new points on the x-axis—points start, finish, and P. Points P and
start should be at the origin. Point P will sweep out the area under the curve
from point start to point finish. Point P has not moved yet, so the measurement
AreaP is zero.
3. Press the Calculate Area button to calculate the area between f and the x-axis
on the interval [start, finish] and to shade in that region.
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Q1 Is the value of the measurement AreaP close to 6 + π? Why isn’t it exactly
6 + π or even 9.142?
Q2 Based on the above reasoning, evaluate
Before you move the
point, check the
status line to make
sure you have
selected the right
point. If you
haven’t, click on
the point again.

4

∫−2 f (x) dx .

4. To check your answer, move point start to point B, press the Reset P button,
and then press the Calculate Area button.
Q3 What do you think will happen to the area measurement if you switch the
order of the integral, in other words, what is

−2

∫4

f ( x) dx ?

5. To check your answer, move point start to x = 4 and point finish as close as
you can get to x = –2, then press the Reset P button.
6. Choose Erase Traces from the Display menu and then press the Calculate
Area button.
Q4 What is the area between f and the x-axis from x = 4 to x = –2?
Now what happens if your function goes below the x-axis? For example, suppose
you want to evaluate

6

∫4 f (x) dx.

D

Q5 Translate the integral into a statement about areas.
Q6 What familiar geometric objects make up the area you
described in Q5?
The grid is shown
here for comparison.
It doesn’t appear in
the sketch.

Q7 Using your familiar objects, evaluate

6

∫4 f (x) dx.

(Hint: You can do this one quickest by thinking.)
7. Make sure point start is at x = 4 and move point finish to
x = 6. Press the Reset P button.

You can also erase
traces by pressing
the Esc key twice.

5

8. Choose Erase Traces from the Display menu, and then press
the Calculate Area button to check your answer. Does the result
agree with your calculation?
Q8 Evaluate

−3

∫−6 f (x) dx using the process in Q5 – Q7 and check

E

your answer using steps 7 and 8.
If you fix your starting point with xstart = –6, you can define a new function,

A( xP ) =

xP

∫−6

f ( x) dx , which accumulates the signed area between f and the

x-axis as P moves along the x-axis.
Q9 Why is A(−6) =

−6

∫−6 f (x) dx = 0 ?

Q10 What is A(–3)?
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To get an idea of how this area function behaves as point P moves along the
x-axis, you’ll plot the point (xP, A(xP)) and let Sketchpad do the work.
9. Move point start to x = –6 exactly. Now move point finish to x = 9. The
To turn off tracing,
choose Trace
Segment from the
Display menu.
If you can’t see the
new point, scroll or
enlarge the window
until you can. To
enlarge the window,
press the Show Unit
Points button, resize
the window, then
press the Set
Function button.

measurement AreaP is now the function A( xP ) =

xP

∫−6

f ( x) dx .

10. Select the line segment that joins point P to the curve. Turn off tracing for the
segment. Erase all traces.
11. Select measurements xP and AreaP in that order and choose Plot As (x, y)
from the Graph menu.
12. Give this new point a bright new color from the Color submenu of the
Display menu. Turn on tracing for this point and label it point I.
13. Press the Reset P button and then the Calculate Area button to move point P
along the x-axis and create a trace of the area function.
Q11 Why does the area trace decrease
as soon as point P moves away
from point start?

D
5

Q12 Why doesn’t the trace become
positive as soon as point P is to
the right of point B?
Q13 What is the significance (in terms
of area) of the trace’s first root to
the right of point start? of the
second root?

y=f(x)

F

B

C

10

A
-5

E

Q14 What is significant about the
original function f ’s roots? Why is this true?
14. Turn off tracing for point I and erase all traces.
Check the status line
to see that point P is
selected. If not, click
on the point again.

Be sure to keep
points A, B, C, D, E,
and F lined up in that
order from left to
right. If point C
moves to the right of
point D, the line
segment CD will no
longer exist.

15. Select points P and I and choose Locus from the Construct menu.
The locus you constructed should look like the trace you had above. The
advantage of a locus is that if you move anything in your sketch, the locus will
update itself, whereas a trace will not.
There are quite a few familiar relationships between the original function f and
this new locus—including the ones suggested in Q11– Q14. See if you can find
some of them by trying the experiments below.
A. Move point B (which also controls point C) to make the radius of the
semicircle larger, then smaller.
B. Press the Set Function button to move point B back to (–2, 0). Now move
point A around in the plane. (Be sure to stay to the left of point B.) Try
dragging point A to various places below the x-axis, and then move point A
to various places above the x-axis.
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C. Press the Set Function button to move point A back to (– 6, – 4). Now move
point D around in the plane. (Be sure to stay between point C and point E.)
Drag point D to various places above the x-axis, and then drag point D
to various places below the x-axis.
D. Follow step C with points E and F.
Q15 List the various patterns that you found between the two functions or in
the area function alone. How many patterns were you able to find? Do you
have any conjectures about the relationship between the two functions?
Explore More
Will the area function’s shape change if you move point start to a value other
than x = – 6?
1. Select point start and move it along the x-axis.
Q1 Does the area function’s shape change when your starting point is shifted
along the x-axis? If so, how? If not, what does change, and why?
Q2 Write a conjecture in words for how the
two area functions
xP

∫x
Be sure to keep
points A, B, C, D, E,
and F lined up in that
order from left to
right. If point C
moves to the right of
point D, the line
segment CD will no
longer exist.

xP

∫−6

f ( x) dx and

5

D

y=f(x)

A

E

f ( x) dx are related.

start

F
start

B

C

finish

2. Make a new shape for your area function
by moving one or more of points A, B, D, E, or F. Then move point start
again along the x-axis.
Q3 Does your conjecture from Q2 still hold? Write the conjecture in integral
notation.
3. Fix point start at the origin. Move point P to the left of the origin but to the
right of point B.
Q4 The following two sentences sound good, but lead to a contradiction. Where
is the error?
The semicircle is above the x-axis from the origin to point P, so the area
is positive. Point I, which plots the area, is below the x-axis, so the area
is negative.
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The Geometer’s Sketchpad Version 4 is available
from Key Curriculum Press in the following packages:
Single-User Package (for one computer)
Software on Windows/Macintosh CD-ROM
More than 100 sample sketches
Learning Guide
Reference Manual
Teaching Mathematics with 25 sample Activity Masters
Quick Reference Guide
101 Project Ideas for The Geometer’s Sketchpad
10-User Lab Pack (for 10 computers in a lab)
Complete Single-User Package
10 Quick Reference Guides
50-User or Unlimited-User School Site License/Network Package
College Campus Site License/Network Package
Complete Single-User Package
20 Quick Reference Guides
Student Edition
Software on Windows/Macintosh CD-ROM
Learning Guide
101 Project Ideas for The Geometer’s Sketchpad
Quick Reference Guide
(requires CD-ROM in drive)

Also available from Key Curriculum Press:
Exploring Geometry with The Geometer’s Sketchpad
Activity book with more than 100 blackline master activities
Covers basic topics of a standard high school geometry course and extensions
Example sketches on Windows/Macintosh CD-ROM
Geometry Activities for Middle School Students with The Geometer’s Sketchpad
Shape Makers: Developing Geometric Reasoning with The Geometer’s Sketchpad
Two activity books that cover middle school geometry topics
Include sketches on Windows/Macintosh CD-ROM
Exploring Algebra with The Geometer’s Sketchpad
Exploring Calculus with The Geometer’s Sketchpad
Exploring Conic Sections with The Geometer’s Sketchpad
Rethinking Proof with The Geometer’s Sketchpad
Pythagoras Plugged In: Proofs and Problems for The Geometer’s Sketchpad
Five books of hands-on activities using dynamic drawings
Flexible format for short courses or student projects
Sketches on Windows/Macintosh CD-ROM
One- or Multi-Day Professional Development Workshops
on The Geometer’s Sketchpad
Available through Key Curriculum Press’s Professional Development Center
Call us at (800) 995-MATH (6284) or access our web home page at
http://www.keypress.com/pdc

